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What’s new in Sibelius 
The improvements detailed below are grouped into topics in alphabetical order, as in the 
Reference section of the User Guide.  All significant improvements since version 1.22 are 
listed. 

Accidentals 
Accidentals are positioned slightly further away from notes in new files, which looks better. 
Existing files are unchanged. (If you prefer the previous distance you can adjust it in the 
House Style dialog box.) 

Articulations 
Articulations now avoid collisions with the new magnetic slurs – either the articulation or the 
slur moves out of the way (depending on the situation). See Lines: magnetic slurs. 
(Note that articulations do not currently avoid colliding with ties, though such collisions are 
less common than with slurs). 

Bar numbers 
New House Style option (Bar numbers page of the House Style dialog box, File 
menu): Center in bar. When this option is switched on, bar numbers are centered over 
each bar. 

Note that bar number changes (i.e. created with the Create > Bar Number Change 
function) are not centered, but you can drag them to the center manually. 

Bars and bar rests 
New House Style options (Bar rests page of the House Style dialog box, File menu): 

••••    Use one bar multirests: this draws 1 above all bar rests (except those with a 
fermata/pause). This option is independent of Show multirests (Layout menu). 
This option can also be switched on when extracting parts; see Options in the Part 
Extraction dialog box.  

••••    Draw H-bar using a symbol: this uses a stretched symbol rather than drawing 
a rectangle to produce the thick bar of an H-bar. This option is switched off by default, 
but you may want to switch it on when using the Inkpen font, as it will give multirests 
a handwritten appearance. (Having the option switched off solves a printing problem 
whereby there is sometimes a gap at the end of the H-bar.)  
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File converters 
Sibelius 1.3 is supplied with converters for files saved in Finale 98, Allegro 98 and PrintMusic 
1.0 for Windows and Mac, and from the Acorn Sibelius programs.  The operation of these 
converters demands more details: see the topics Finale, Allegro and PrintMusic 
file conversion and Acorn file conversion later in this booklet. 

Files 
From version 1.3 onwards, Sibelius files are forwards compatible. This means that version 
1.3 will be able to open files created on later versions of Sibelius for the foreseeable future. 
If a feature present in a later version of Sibelius is used in a file opened by an earlier version 
of the software, a warning will appear and objects affected by that feature will simply not 
display when opened in the earlier version. 

Note that version 1.3 can open files from all previous versions of Sibelius, but that previous 
versions of Sibelius (i.e. all versions up to and including v1.22) cannot open files saved in 
version 1.3. This means that if you update to version 1.3 and sometimes send files to other 
people, you should encourage them to update to version 1.3 as well. 

When opening in version 1.3 a file saved in a previous version of Sibelius for the first time, a 
new Update Score dialog box will appear; this gives you the option of updating your 
scores to use the new magnetic slurs feature. Generally you should switch on all the 
conversion options in this dialog box, unless you know you will need to edit the score again 
in a previous version of Sibelius – once you have saved the score in version 1.3, it will no 
longer be possible to open it in previous versions. 

Graphics files (Windows only) 
EMF file export has been modified to make them readable by more programs. 

Guitar frames 
You can now edit an existing guitar frame by double-clicking it in the score. 

Instruments 
• Guitar [tab] and Electric guitar [tab] now have no rhythms (stems, rests, etc.) 

by default – existing scores are unaffected.  

• The Bass guitar instrument now plays back in the correct octave (this only applies 
when you create a new bass guitar, existing scores are unchanged). 
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Internet publishing 
Save as Scorch web page now removes any spaces from the filenames of both the 
Sibelius (.sib) and HTML (.htm) files and shortens the name to 27 characters plus a 3 
character extension to make them safe for all servers.  

Save as Scorch web page also now warns the user that the web page template uses 
some fields from Catalog Info (File menu) that haven’t been filled in for that particular 
score. For example, with the standard web templates Sibelius warns you if you forget to set 
the title and composer, as these are written above the score in the resulting web page. 

Keyboard shortcuts 
There is a new Flip Object item in the Layout menu, with shortcut X. We expect to 
make X flip other objects in future, e.g. ties. This function flips note stems and also slur 
directions (above/below the notes). (The flip stem button on the third keypad layout still 
works but it’s easier just to type X.) 

Lines: magnetic slurs 
Version 1.3 introduces a new type of slur which snaps to notes, so that if you change the 
pitch of notes or add articulations, the slur moves: meet the magnetic slurTM. 

This improves: 

• typing S to add a slur to a note (these now work correctly with beams and with notes 
in multiple voices);  

• editing notes;  

• transposing (e.g. when extracting parts);  

• grace notes (slurs now attach to them in the same way as normal notes).  
 

Old-style non-magnetic slurs appear red when selected (partly as a warning that you may 
want to make them magnetic). 

To create a magnetic slur, select a note (or grace note) and type S, as before. S now puts 
the slur starting at the notehead end of the first note; in two or more voices, S puts the slur 
above a stem-up note and below a stem-down note. Shift-S puts the slur at the opposite 
end. We have used this rule (rather than the old behavior of S putting a slur above the 
note) because this is a smarter default, i.e. follows standard engraving practise in most 
cases. For a stem-up note in one voice, there are a couple of exceptions where you should 
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type Shift-S to put the slur at the stem end (above) rather than at the notehead end 
(below). These are: 

• if any later note stems within the slurred group point down, or  

• if the slur is long (say, two or more bars).  
 
You can type X (the new keyboard shortcut for Flip Object in the Layout menu; see 
Keyboard shortcuts) to flip a slur vertically to the other side of a note. Note that this 
shortcut doesn’t currently flip ties, although we plan to include this in a later update. 

When dragging a magnetic slur it snaps to each note it passes over. Note that magnetic slurs 
over page breaks can sometimes change direction. If you want to ensure that a slur doesn’t 
change direction over a page break, use a non-magnetic slur instead. 

Slurs now have handles when selected, which makes them easier to select (if one end of the 
slur is selected, only that end gets a handle). 

If you use Snap Object (Layout menu, or type XS or Ctrl+Shift+S) to snap a slur, 
this also turns it into a magnetic slur if it was non-magnetic. 

Note that magnetic slurs do not attach to cross-staff notes. The slur will naturally go to 
where the note would be on the original staff, but you can drag the slur’s end to the note’s 
actual position. 

Magnetic slurs have a maximum angle for esthetic purposes; if a magnetic slur would 
otherwise exceed this angle, it is drawn from one of the notes to a point above or below the 
other. 

There are new options on the Slurs page of the House Style dialog box (File menu) 
relating to magnetic slurs: 

• Minimum distance    x    spaces from staff line prevents the ends of slurs 
touching staff lines.  

• The Avoiding articulation options specify the distance between ends of slurs and 
articulations on the same note. 

Lines: non-magnetic slurs 
Although we don’t recommend it except for special circumstances, you can still create non-
magnetic slurs using the mouse – either by selecting a slur from the Lines dialog box 
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(Create menu), or by typing S (slur above) or Shift+S (slur below) when no note is 
selected.  

Non-magnetic slurs appear in red when selected, as a hint that you should probably use a 
magnetic one instead.  

You can make a non-magnetic slur magnetic by snapping it to the notes: select it and type 
xXS or Ctrl+Shift+S (or choose Snap Object on the Layout menu).  

If you want a magnetic dotted slur, for instance, choose one from the Lines dialog box, put 
it in the score with the mouse (at which point it will be non-magnetic), then snap it to make 
it magnetic.  

Look and feel 
The toolbar icons in Sibelius have been redesigned; their position and function remains 
identical to that of previous versions.  

A brief musical excerpt now plays when Sibelius is run; to silence it, switch off Play music 
at start in the Preferences dialog box (File menu). The excerpt is from Sibelius’ 7th 
Symphony, played, appropriately enough, by Finland’s Lahti Symphony Orchestra.   

Lyrics 
Reset Note Spacing (Layout menu, or type XR or Ctrl+R) now makes room for 
lyrics when respacing music. Hurrah!  

New House Style option (Text page of the House Style dialog box, File menu): Use 
text hyphens (not symbols). This is switched on by default, even when opening an 
old score. The built-in hyphen that was Sibelius’ previous default was a symbol, and 
sometimes undesirable because it was italic and its size did not vary according to the font 
used for the Lyrics text style.   

MIDI equipment 
We have included six new patch files with this version of Sibelius, for the following sound 
modules: 

• E-MU Proteus 2  

• E-MU Proteus 2000  

• Kurzweil K2500 orch board  

• Roland JV-1010  
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• Roland JV-1010 (orch board)  

• Roland XP-30 

Multirests 
Multirests can now be forced to split into two at any point: 

• Switch off Show Multirests (Layout menu) if they’re on – xXM or 
Ctrl+Shift+M    toggles this function.  

• Select a barline and choose Split Multirest from the Layout menu or type 
xXP or Ctrl+Shift+P; a double-slash will appear on the screen above the 
barline (although not when you print), similar to system and page breaks (you can 
hide or show these marks by toggling the Breaks option in the View menu).  

• If you switch on Show Multirests again or extract parts; the multirest will now 
split at the chosen barline.  

 

If you select a passage and choose Split Multirest, then any multirest is forced to split 
either side of the passage, and any splits within the passage are removed. This means that if 
all the bars are empty, the selected passage will become a single multirest (when Show 
Multirests is switched on). 

Note that if there are any notes, text or other objects in the passage, they will split up the 
multirest anyway; you can’t use this to hide them. 

Notes, chords and rests 
New House Style option (Notes page of the House Style dialog box, File menu): New 
stem length rule. This makes the stems of notes on or either side of the middle staff 
line 0.25 spaces longer than before, which many engravers and publishers prefer. This 
option is switched on in new scores; when opening old scores the Update Score dialog 
box gives you the option to switch it on.  

X↑/↓ or Ctrl+↑/↓ now changes stem lengths in 0.25 space increments, not 1 space as 
previously.  

OMS and FreeMIDI (Mac only) 
Version 1.3 of Sibelius now supports both OMS and FreeMIDI.  You have to use one of 
these programs to specify your MIDI equipment before playing/recording, in the same way 
that you have to use the Chooser to specify your printer before printing. 
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Both OMS and FreeMIDI are included on the version 1.3 CD-ROM. For more information on 
which, if either, of these packages you need to install, see the OMS and FreeMIDI 
topic later in this booklet. 

Plug-ins 
The following plug-ins have been added since v1.22: 

••••    Convert Finale Files    – converts multiple files in a folder; see File converters 

••••    Convert Sibelius 7 Files    – converts multiple files in a folder; see File 
converters 

••••    Keyboard reduction    (formerly called Implode)    – creates a single- or two-staff 
reduction of a larger score; simply create a new single staff or piano as the first (i.e. 
topmost) instrument in your score, and run the plug-in.  

••••    Cresc. & Dim.    – allows playback of dynamic changes over sustained notes  

••••    Accel. & rit.    – enables playback of gradual tempo changes  

••••    Add interval above/below    – can add notes of any interval above or below a 
selected passage  

••••    Transpose to one note    – transposes the selected passage to a single pitch, 
useful for rhythm notation.  

 

A new AddText function has also been added to the ManuScript language which allows 
programmers to refer to text styles by number rather than by name; this ensures that plug-
ins will work on different language versions of Sibelius. 

Scanning 
Tuplets now import from the full version of PhotoScore. Note that only the full version of 
PhotoScore (not PhotoScore Lite, which is supplied free with Sibelius) can handle tuplets, 
and it does not automatically read them: you have to create them after the score has been 
read. 

PhotoScore Lite has been updated to version 1.75, and is included on the Sibelius CD-ROM. 
For details of what has been changed in this version, see What’s new in 
PhotoScore Lite later in this booklet. 



Improvements in version 1.3 

12 

Text 
You can now change the text style of an existing text object. Select the text and type XI or 
Alt+Enter to view its Properties dialog box (or choose Properties from the Edit 
menu). In the Text tab of this dialog box you can change the text style from a list. 

Note that only compatible text styles are shown: for instance, if you select some Title text, 
Subtitle appears on the text style list, but not Expression (since you can only change to 
another system text style). 

There are also new alignment options for text styles; on the Horizontal Posn tab of the 
Edit Text Style dialog box there are new options for aligning text objects to the page. 

Transferring and uninstalling Sibelius 
When you Transfer saving out (File > Register/Transfer), you are now asked to 
type in the transfer key again as a check in case you didn’t write it down properly. 

Tuplets 
There is a new House Style option (Text    page of the House Style dialog box, File 
menu): Rotate single digits. This option is switched off by default (even in old scores, 
where single digit tuplets were previously drawn rotated). Tuplet text consisting of multiple 
digits (e.g. ‘12’ or ‘3:2’) has to be drawn at the same angle as the bracket to align with it, but 
single digits can look better drawn upright instead. 

Bug fixes 
Numerous minor bugs have been fixed in this release, including: 

••••    Go To Bar and Go To Page now take account of the first bar and/or page 
number not being 1.  

• Grace-notes can now be entered just before a barline.  

••••    Show cautionary option in the Properties dialog box for time signatures now 
selectable (Mac only).  

• Dragging off the edge of the Navigator caused pages to speed past uncontrollably; 
this is now fixed (Mac only).  

• The occasional misalignment of barlines at the end of systems has been fixed (the 
barline would appear slightly detached from the right-hand end of the system). If the 
problem occurred with a ‘special’ barline (e.g. final etc.) in an existing score, you may 
need to respace the bar before the problem barline.  
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• The German version of Sibelius for Mac now correctly installs the globals.txt file 
required by ManuScript plug-ins.  

• Saving was sometimes disabled after printing a single page.  

• H-bars are now the correct thickness on multirests on small staves (Mac only).  

• Some text styles marked as not ‘Playable’, such as ‘Small text’, still affected playback; 
this is now fixed. If you previously deliberately used one of these text styles to affect 
playback, you will now have to switch on the Playable option in the Edit Text 
Style dialog box to restore the previous behavior.  

• The Sibelius application icon sometimes went missing; now fixed (Windows only).  

• Lyric lines (e.g. for melismas) were drawn too far away on small staves.  

• Some plug-in dialog boxes displayed incorrectly (Mac only).  

• Plug-in dialog editor now works correctly (Mac only).  

• Active Sensing MIDI devices (e.g. Yamaha keyboards) no longer cause the input 
indicator in the Equipment dialog box (Play/Flexi-time menu) to light up 
continuously.  

• Print range (Print dialog box) was sometimes ignored on some Apple Laserwriter 
printers (Mac only).  

• Bar Properties dialog box now appears correctly (Mac only).  

• Display problems with music fonts on Korean versions of Windows now fixed 
(Windows only).  

• On certain computers, editing text would result in spurious characters (e.g. ‘RPAR’ and 
‘fofs29’) being inserted; this is now fixed (Windows only).  

••••    Test button in the Equipment dialog box now works with the Microsoft GS 
Wavetable Synth under Windows 2000.  

• Printing problems (i.e. blank pages) with the Brother HL-1250 USB laser printer on 
Mac have been fixed; this should also fix problems with other similar printers (Mac 
only).  

Known problems 
The following are known problems with this release: 

• When opening scores saved in older versions of Sibelius, some users have 
experienced problems when choosing to update slurs to the new magnetic slurs in 
the Update Score dialog box. If you experience such problems, simply choose not 
to update slurs in that particular score and update them manually.  
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• Mac users with the Okey Dokey Control Panel can get a crash in Sibelius’ Lines 
dialog box. This is due to a conflict in an early version of Okey Dokey. The solution is 
to remove the Control Panel, or possibly to upgrade it (v2.0.3 seems to work more 
reliably). 
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Finale, Allegro and PrintMusic 
file conversion 

Sibelius’s built-in Finale file converter allows you seamlessly to open files created in Finale 
98, Allegro 98 and PrintMusic 1.0 (including Finale’s Enigma files). With files earlier than 
Finale/Allegro 98, the converter asks you to re-save the file from Finale/Allegro 98 to update 
it; this enables Sibelius to open them.  

The purpose of the file converter is to save you time, not to convert every score so that it is 
identical to the original. As with any file converter, this is unrealistic, since 
Finale/Allegro/PrintMusic and Sibelius work in different ways and have different features. 

Converting a file 
In Sibelius, click Open (or type XO or Ctrl+O), find the Finale, Allegro, PrintMusic or 
Enigma file and simply click Open. (If the file is not visible in this dialog box, make sure 
that the filename has a .mus extension, or .etf for Enigma files. This works on Mac as well 
as Windows.) After a short delay the file will open. You should then check it and edit it as 
necessary. 

Batch conversion 
Sibelius includes a plug-in to convert a complete folder full of Finale files at once. It works 
equally well with Allegro and PrintMusic files. 

To use it, from Sibelius’ Plug-ins menu choose Convert Finale Files. You are asked to 
find the folder to convert; find it and click OK. All Finale files in the folder (including Enigma 
.etf files) will be converted to Sibelius files. 

Note that if the files were created by versions of Finale or Allegro prior to Finale/Allegro 98 
you should update the files by opening and re-saving them using Finale/Allegro 98 before 
running the plug-in. 

Warning messages 
Some Finale files will contain notations that the file converter is aware may not be converted 
correctly. If so, during conversion a dialog box appears with a list of warnings, giving the 
severity of each problem and the staff and bar number where it occurred. Staves are 
numbered such that the topmost staff is 1 (hidden staves are still counted – for a list of all 
staves you can look in Sibelius’ Sounds dialog box). 
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The warning list is useful when editing the file: you may want to use it as a basis for proof-
reading the score. 

The warning dialog box has a Save button to save the warnings as a text file to print out or 
give to a proof-reader. You can save the warnings at any point – if converting a series of 
files, the warnings accumulate so you can wait till the end before saving. 

Mac memory 
With large files it is possible for the file converter to run out of memory on Mac computers 
(this is unlikely to be a problem on Windows). Sibelius may either tell you that there is no 
more memory, or it may just give up converting a file. 

If so, you should increase Sibelius’s memory allocation. Select the Sibelius program file (in 
the Sibelius folder) and type XI to see the File Info dialog box. Find the Memory 
area and increase the Preferred Size (as a guide, 25Mb is enough to convert a 2.5Mb 
Finale file of an orchestral score). It is also a good idea to switch on virtual memory in the 
separate Memory Control Panel (although be aware that playback in Sibelius through 
QuickTime is adversely affected by having virtual memory switched on). 

Update Layout error message 
Some scores may generate an error message telling you to update the layout. You should 
do the following: 

• Open the score in Finale/Allegro 98 

• Go to the last page of the score 

• Whilst on the last page, choose Update Layout from the Edit menu 

• Save the score and open it again in Sibelius. It should now convert correctly.  

Quality of the results 
The quality of the results is generally good: standard notations normally convert well, and 
the converter even understands various ‘fakes’ that are commonly used in Finale and turns 
them into proper notations in Sibelius. The converter knows when a notation may not 
convert correctly, so it shows you a dialog box listing the staff and bar of any problems 
which occur. You can save this list if you want to print it out or proof-read the score later. 

The limitations are summarized below. Most of them don’t occur often because they tend to 
be obscure features in Finale (and also Allegro and PrintMusic, if they support the feature in 
question) that are seldom used in practice, e.g. mirrored notes. 
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Feature Limitations 

Accidentals In some obscure situations involving tied notes in multiple voices, or notes tied to 
nothing, an accidental may be wrongly converted 

Articulations The following Finale articulations are omitted (some of these are not normally 
notated as articulations anyway): trill extension, trill, broken chord, double slash, 
grace note, diamond, brackets, tenuto + accent (as a single articulation) 

Articulations input using the Finale Expression tool are not imported 

Articulations that convert to standard Sibelius articulations (accents, tenuto, staccato, 
etc) go at Sibelius’s default position 

Bar numbers You can choose whether to convert them to Sibelius native bar numbers or to 
Sibelius text in the Options dialog box when you open a file; converting to text allows 
more Finale options to work correctly, but may make the score harder to edit 

Barlines Manual horizontal barline adjustments with the Finale Measure Tool are ignored 

Graphic barlines are omitted 

Thick barlines import as double barlines 

Ticks import as regular barlines 

Beams Secondary beam breaks are converted to continuous secondary beams 

Brackets and braces Line brackets import as regular brackets 

With the exception of the horizontal position of braces, brackets that have been 
manually repositioned in Finale are imported using Sibelius spacing 

Second individual placements of brackets are not converted (this is set globally in 
the Sibelius House Styles dialog box) 

Grace-notes Grace note beaming may not always convert accurately 

Guitar frames Guitar frames faked using guitar font characters typed into text are imported 
correctly. ‘Native’ Finale guitar frames do not always currently import. 

Guitar tab  Finale stem adjustment options in tab do not convert 

Finale TAB clef options are not supported 

Key signatures Independent key signatures on different staves import as default key signatures 

Non-standard key signatures (e.g. 3 sharps + 2 flats) are omitted. Finale scores that 
use these key signatures will import with incorrect enharmonic spellings 

Finale key signatures hidden on a per-bar basis are not converted 
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Feature Limitations 

Layout and spacing Margins are adjusted to avoid spilling off the page 

Finale’s horizontal note spacing is ignored; Sibelius’ default spacing rules (which are 
often better) are used instead 

Finale systems that overlap vertically will import as two separate systems with 0 
separation 

Lines Lines designed using the Finale Shape Designer are not imported 

The positioning of trill extensions is not always accurately imported 

Lines that begin and end on different staves are omitted 

Flipped stem directions can cause slurs to be incorrectly positioned 

Finale slur thickness option is ignored 

Values specified by the Finale function Avoid Staff Lines by at Least x 
amount are ignored 

Slurs created as Finale Shape Expressions are not imported 

Slurs attached to grace notes may have inaccurate positions 

Custom designed repeats do not convert 

Lyrics Finale lyric alignment (left, right, centre) imports as Sibelius default alignment 

Lyrics are respaced according to Sibelius’s rules 

Notes  and ties You can set the notehead size (as a percentage of Sibelius’s normal size) in the 
Options dialog box when you open a file 

Default Finale stem directions import as Sibelius default stem directions, so in some 
cases they may point in the other direction 

Cross-staff notes are implemented using Sibelius’s rules, so the following are left on 
the original staff: notes in a chord individually crossed to another staff, and notes 
crossed to a staff in another instrument or in a non-adjacent staff 

Part extraction Some part extraction options are not imported (e.g. markings that are extracted into 
some parts and not others) 

Playback MIDI playback settings are imported from layer 1 of Finale staves. Settings in other 
layers are ignored 

Rehearsal marks Rehearsal marks convert as text in the Rehearsal Marks text style. This means they 
will not automatically renumber/reletter if subsequently edited 

Rests The vertical position of rests is converted to Sibelius’s default position 

Symbols Staff Expression tool symbols are omitted 
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Feature Limitations 

Text Finale text items with embedded current date and time are imported with the date 
and time of conversion 

Certain text characters (e.g. accented letters) will import more accurately if the Finale 
file is imported on the same platform (Mac or Windows) as it was originally created 
on (because the Finale file format is not properly platform-independent) 

Transposition changes The following features in the Finale Staff Transpositions dialog are ignored: Simplify 
key; Chromatic transpositions; Set to clef 

Tuplets The vertical position of tuplet brackets is not imported 

Finale tuplets with no bracket by default are imported with a bracket 

Finale ratios are imported with the second figure of the ratio 

Finale brackets drawn as slurs import as square brackets 

Voices Mirrored notes (rarely used) will not import correctly. This can be worked around by 
converting all notes to normal notes before importing the file 

Finale’s 4 layers and 2 voices are mapped onto Sibelius’ 4 voices. This works for all 
practical cases, but one can contrive obscure situations where this mapping cannot 
be done and notes are omitted (e.g. where you are using 5 or more layer/voice 
combinations in Finale at once) 
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Acorn file conversion 
Sibelius’s built-in Acorn file converter allows you to open seamlessly files created in the 
original Acorn Sibelius programs (Sibelius 7, Sibelius 7 Student, Sibelius 6 and Junior 
Sibelius), version 3.01 or later. With files earlier than version 3.01, the converter asks you to 
re-save the file from version 3.01 or later to update it; this enables Sibelius for 
Mac/Windows to open them. 

The purpose of the file converter is to save you time, not to convert every score so that it is 
identical to the original. As with any file converter, this is unrealistic, since the Acorn and the 
Mac/Windows versions of Sibelius work in different ways and have different features. 

Thanks to all the Acorn users who’ve been beta-testing this over the last year. 

Transferring files from Acorn to PC or Mac 
The simplest way to transfer the files is as follows: 

1. Format a floppy disk as DOS 1.44Mb format (you can do this on your Acorn or your 
PC/Mac; new disks are normally formatted like this anyway). Then just copy the Acorn 
files onto the floppy disk, click the Menu button on the floppy drive icon (marked 
:0) on the icon bar, and choose Dismount, to ensure the files are fully saved.  

2. Eject the disk and insert it in your PC or Mac. 
3. Copy the files from the floppy disk onto your PC or Mac’s hard disk before converting, 

as they will then convert quicker.  
4. Add .s7 to the filename to show that they are Acorn Sibelius files (use .s7 for 

Sibelius 6 files as well). Alternatively, you can rename them when they’re still on your 
Acorn: add /s7 to the end instead, and the slash will appear as a dot on your 
PC/Mac.  

Converting an Acorn Sibelius file 
In Sibelius for Mac/Windows, click Open (or type XO or Ctrl+O), find the Acorn 
Sibelius file (with its .s7 extension) and click Open. We recommend that you don’t open a 
file direct from a floppy disk – copy it to your hard disk first. After a short delay the file will 
open. You should then check it and edit it if necessary. 

If the file is earlier than Acorn Sibelius version 3.01, you will be asked to re-save the file from 
version 3.01 or later to update it, then try again. 
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Batch conversion 
Sibelius includes a plug-in to convert a complete folder full of Sibelius 7 files at once. To use 
it, in Sibelius for Windows/Mac choose Convert Sibelius 7 Files from the Plug-ins 
menu. You are asked to find the folder to convert; find it and click OK. All Sibelius 7 files in 
the folder will be converted to Sibelius for Windows/Mac files. 

Note that if the Sibelius 7 files were prior to version 3.01 format, you should load them into 
Sibelius 7 version 3.01 or later and re-save them prior to converting them. 

Mac memory 
With large files it is possible for the file converter to run out of memory on Mac computers 
(this is unlikely to be a problem on Windows). Sibelius may either tell you that there is no 
more memory, or it may just give up converting a file. 

If so, you should increase Sibelius’s memory allocation. Select the Sibelius program file (in 
the Sibelius folder) and type XI to see the File Info dialog box. Find the Memory 
area, and increase the Preferred Size (in extreme cases 50Mb or more may be 
appropriate). It is also a good idea to switch on virtual memory in the separate Memory 
Control Panel. Note that playback in Sibelius through QuickTime music is adversely affected 
by having virtual memory switched on. 

Limitations 
The main limitations are summarized below – some very technical limitations are omitted. 
 

Feature Limitations 

Accidentals In two voices, an accidental on a note in one voice is not implicitly applied to notes of the 
same pitch in the other voice; it must appear in both voices to convert correctly. 

Accidentals tied across barlines may convert incorrectly on the second note (see Notes and 
ties, below) 

Articulation Some pauses on bar rests are not imported 

Bar number 
changes 

Bar number changes are not imported  

Clefs Perhaps some problems with octava clefs in some cases 

Erasers Not imported (no direct equivalent) – can usually be replaced in Sibelius for Mac/Windows 
with a divided system, ossia, ‘hidden’ staff type change, or tilde before text to hide 

Grace-notes Not imported 
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Feature Limitations 

Guitar frames Not currently imported (these were a late addition to Sibelius 7 and are little used) 

Guitar tab  This is converted in a basic way by converting the text that makes up Sibelius 7 guitar tab, even 
though the result is not real Sibelius for Mac/Windows guitar tab 

House Styles Mostly set to the Sibelius for Mac/Windows default, e.g. page numbers are reset to start at 1 

Layout / 
Spacing 

System/page breaks are converted but otherwise the pagination may change. You can correct 
this using Sibelius for Mac/Windows’ Make Into System/Page features. 

Gaps between staves may not be the same 

Note spacing uses Sibelius for Mac/Windows’ standard spacing which is slightly different than 
on Acorn 

Lines Not all lines are converted to equivalents; ones that are not are converted to simple straight 
lines 

Notes and ties Slurs and ties are the same in Acorn Sibelius, so the converter guesses which ones to convert 
to ties in Sibelius for Mac/Windows.  

Occasionally the converter will mistakenly convert a slur to a tie, because it happens to look 
like one in context. It’s easy enough to edit them back, though the appearance is often correct 
even if you leave them as ties.  

Part extraction If parts are extracted from a converted Acorn Sibelius file, a few transposing instruments may 
appear in the wrong octave. These can easily be corrected by transposing the affected parts by 
an octave  

Playback MIDI playback settings are not imported, so most instruments default to a piano sound. Use 
Sibelius’s Sounds dialog box to set up the sounds correctly 

Rehearsal 
marks 

Not imported 

Rests Breve bar rests are imported as normal bar rests 

Staves Occasional hidden staves may reappear after conversion, and can be suppressed using Hide 
Empty Staves (Layout menu) 

Symbols Symbols (‘Transfers’) are not imported 

Text Duplicated tempo text is imported as a single text item 

Text style definitions are not imported; this means that text fonts are re-defaulted 

Player text is not imported (no direct equivalent in Sibelius for Mac/Windows) 
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OMS and FreeMIDI – Mac only  
Note: If you have already set up OMS with a previous version of Sibelius and 
don’t use any other music programs, there is no need to change to using 
FreeMIDI. If, on the other hand, other music programs on your computer 
require FreeMIDI, you may find it useful to set Sibelius up to use it too. 

To decide what to install: 

• If you don’t have any MIDI equipment (keyboards, sound modules, etc.), you don’t 
need to install OMS or FreeMIDI. Sibelius can play reasonable quality sounds through 
your Mac’s speakers instead (using QuickTime).  

• If your MIDI equipment is connected to an OMS-compatible MIDI interface, see 
Setting up OMS below.  

• If your MIDI equipment is connected to a FreeMIDI-compatible MIDI interface, see 
Setting up FreeMIDI below.  

• If you are using FreeMIDI-compatible applications and OMS-compatible applications 
simultaneously, see Setting up FreeMIDI in OMS compatibility mode 
below.  

• If you are using FreeMIDI-compatible applications and OMS-compatible applications 
separately, see Setting up FreeMIDI and OMS separately below. 

 
Compatible MIDI interfaces 

MIDI interfaces that support FreeMIDI include: MOTU 1296, MOTU 24i, MOTU 308, MOTU 
1224, MOTU 2408, MTP AV USB, MIDI Express XT USB, Micro Express USB, FastLane USB. 

MIDI interfaces that support OMS only include: Roland Super MPU64 and MIDIMan 
MIDISport 2x2 USB. 

Using OMS and FreeMIDI in Sibelius 
• OMS and FreeMIDI recommend you switch off virtual memory when using them – 

choose the Memory Control Panel from the Apple menu to toggle this. To make 
sure, Sibelius refuses to use FreeMIDI if virtual memory is switched on.  

• If you have both OMS and FreeMIDI installed, Sibelius assumes by default that you 
want to use FreeMIDI (because you can always use FreeMIDI compatibility mode to 
use OMS from FreeMIDI). Advanced users can change this assumption by editing the 

m 
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Preferences file in your Sibelius folder: set the value after PreferredMIDISys 
to 1 for OMS and 2 for FreeMIDI.  

• When using OMS or FreeMIDI a submenu called OMS or FreeMIDI appears in the 
Play/Flexi-time menu. The OMS menu contains options MIDI Setup, Studio 
Setup and Panic. The FreeMIDI menu contains Interface Settings, Edit 
Configuration and Panic. Panic silences all the sounds, similar to the option All 
Notes Off (Options submenu of the Play/Flexi-time menu). The other menu 
options take you to setup features in OMS and FreeMIDI that are also available in 
those programs directly. Note that when using FreeMIDI in OMS compatibility mode 
the FreeMIDI options are shown. 

Setting up OMS 
• Install OMS by double-clicking on the Install OMS icon and following the on-screen 

instructions  

• Connect your OMS-compatible MIDI interface to the serial or USB port of your Mac 
and install any necessary drivers (refer to the documentation that came with your 
MIDI interface for details). Ensure that any MIDI/Thru switches are in the MIDI 
position, and that all MIDI devices are switched on  

• Locate and open the OMS Setup application  

• The Create a New Studio Setup dialog box appears. Click OK  
• Click the checkboxes to select the port (modem and/or printer) to which your MIDI 

interface is connected. USB MIDI interfaces will be detected regardless of these 
settings  

• Click Search. OMS will now search for MIDI interfaces connected to your computer  

• A list of the MIDI interfaces connected to your computer will be displayed. If this list is 
correct, click OK. If MIDI interfaces that you have connected to your computer are not 
detected, refer to the troubleshooting information  

• OMS will now attempt to detect devices (keyboards, modules, samplers, etc.) that are 
connected to your MIDI interface. A list of devices or MIDI ports will appear. Click on 
the checkboxes next to each of the devices or ports that you wish to use. Click OK  

• You will now be presented with a standard Mac OS Save dialog box. Name your 
configuration, choose a convenient place on your hard drive and click Save  

• Your studio configuration will now be displayed. Check that the on-screen MIDI 
connections are the same as your studio’s physical connections. Device information 
(manufacturer, model, name, properties, receive channel(s) and icon) can be edited 
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by double-clicking on the device/MIDI Interfaces icon. To connect devices, drag them 
to a MIDI interface, disconnect devices, and click once on the in/out arrows  

• When you have completed the setup, choose Save from the File    menu  

• Quit OMS Setup  

• Run Sibelius  

• Set up the Equipment dialog box as detailed in MIDI Equipment in the 
Sibelius User Guide.  

Setting up FreeMIDI 
• Install FreeMIDI by double clicking on the Install FreeMIDI icon and following the 

on-screen instructions  

• Connect your FreeMIDI-compatible MIDI interface to the serial or USB port of your 
Mac  

• Locate and open the FreeMIDI Setup application  

• If you have OMS installed on your computer, you will be asked whether you wish to 
use OMS or FreeMIDI. Choose FreeMIDI (this can be changed later from 
Preferences in the File    menu within FreeMIDI Setup)  

• The Welcome to FreeMIDI dialog box appears. Click Continue  
• The FreeMIDI Preferences dialog box appears. Ensure that only Allow other 

applications and Always load at startup are switched on. Click OK to 
continue  

• The About Quick Setup dialog box appears. Click Continue  
• You will now see the Quick Setup window. In the New Device section of the 

Quick Setup dialog box specify the Manufacturer, Model, Studio Location 
(the name of the MIDI interface to which the device is connected) and Cable (the 
port to which the device is connected to if the specified MIDI interface has multiple 
ports). Click Add after specifying each device to add it to the Current 
Configurations list  

• When you have specified the relevant information for each of your MIDI devices, click 
Done. Make sure ‘Controller’ is selected in Properties if the device is to be used 
as an Input Device  

• Your studio configuration will now be displayed. Check that the on-screen MIDI 
connections are the same as your studio’s physical connections. Device / MIDI 
Interface information (name, ID, manufacturer, model, transmit channel(s), receive 
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channel(s), properties and icons) can be edited by double-clicking on the device / 
MIDI Interfaces icon  

• Choose Save from the File menu. Name your configuration and save it in a 
convenient place on your hard drive  

• Quit FreeMIDI Setup  

• Run Sibelius  

• Set up the Equipment dialog box in the same way as you would with OMS    – see 
MIDI Equipment in the Sibelius User Guide.  

Setting up FreeMIDI in OMS compatibility mode 
• Install FreeMIDI by double-clicking on the Install FreeMIDI icon and following the 

on-screen instructions  

• Install OMS by double-clicking on the Install OMS icon and following the on-screen 
instructions  

• Connect your FreeMIDI or OMS compatible MIDI interface to the serial or USB port of 
your Mac  

• Locate and open the OMS Setup application  

• The Create a New Studio Setup dialog box appears. Click OK  

• Click the checkboxes to select the port (modem and/or printer) to which your MIDI 
interface is connected. USB MIDI interfaces will be detected regardless of these 
settings  

• Click Search. OMS will now search for MIDI interfaces connected to your computer  

• A list of the MIDI interfaces connected to your computer will be displayed. If this list is 
correct, click OK. If MIDI interfaces that you have connected to your computer are not 
detected, refer to the troubleshooting information  

• OMS will now attempt to detect devices (keyboards, modules, samplers, etc.) that are 
connected to your MIDI interface. A list of devices or MIDI ports will appear. Click on 
the checkboxes next to each of the devices or ports that you wish to use. Click OK  

• You will now be presented with a standard Mac OS Save dialog box. Name your 
configuration, choose a convenient place on your hard drive and click Save  

• Your studio configuration will now be displayed. Check that the on-screen MIDI 
connections are the same as your studio’s physical connections. Device information 
(manufacturer, model, name, properties, receive channel(s) and icon) can be edited 
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by double clicking on the device / MIDI Interfaces icon. To connect devices, drag them 
to a MIDI interface, disconnect devices, and click once on the in/out arrows  

• When you have completed the setup, choose Save from the File menu  

• Quit OMS Setup  
• Locate and open the FreeMIDI Setup application  

• You will be asked whether you wish to use OMS or FreeMIDI. Choose OMS. To 
change this later you will need to quit Sibelius, locate and run the FreeMIDI Setup 
application, open FreeMIDI Preferences (File menu) and switch on ‘Use OMS 
when available’. Quit FreeMIDI and run Sibelius.     

• A dialog box will appear informing you that FreeMIDI is in OMS compatibility mode. 
Click OK to continue. Your OMS Studio Setup will be displayed. Quit the FreeMIDI 
Setup application.  

• Open Sibelius.  

• Setup the Equipment dialog box in the same way as you would with OMS    – see 
MIDI Equipment in the Sibelius User Guide.  

Using FreeMIDI Patch lists in OMS when using FreeMIDI in OMS 
compatibility mode 

If you are using FreeMIDI in OMS compatibility mode, no patch names will be listed in 
Sibelius’ Sounds dialog box (Equipment menu, or type I). For the correct patch names 
to be displayed, OMS must use FreeMIDI patchlists. To do this, Mark of the Unicorn 
recommend the following: 

• Quit FreeMIDI Setup and OMS Setup  

• Locate the Factory Names folder found in the OMS Folder within your 
System folder.  

• Open the Factory Names folder, and remove the contents (you may want to back 
up the contents of this folder, or simply delete them)  

• Open the OMS Preferences folder (in the OMS Folder) and delete the file 
OMS Name Manager Prefs  

• Launch OMS Setup, delete visible OMS Devices, and reconfigure the OMS 
Setup  

• When adding devices in OMS, be sure to choose from the list of Manufacturers and 
Models. If your device is not listed, assign a similar device, and modify its name to 
match your device (e.g. change ‘JV-1080’ to ‘JV-2080’)  
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• After completing your OMS Setup, choose Save and Make Current from the 
File menu.  

• Run FreeMIDI Setup  
• Open the FreeMIDI Preferences window (File menu), and choose Use OMS 

when available from the Software Compatibility section. You may need to 
quit and launch FreeMIDI again so FreeMIDI opens using OMS’ setup  

• The same OMS setup above will appear in FreeMIDI. More importantly, the FreeMIDI 
patchlist will remain intact  

• This trick only works when a FreeMIDI application is using the OMS setup. This 
method does not publish patch lists directly into OMS to use with software like 
ProTools, Studio Vision, Cubase and some other OMS compatible software. 

Setting up FreeMIDI and OMS separately 
• Install FreeMIDI by double-clicking on the Install FreeMIDI icon and following the 

on-screen instructions  

• Install OMS by double-clicking on the Install OMS icon and following the on-screen 
instructions 

• Connect your FreeMIDI- or OMS-compatible MIDI interface to the serial or USB port 
of your Mac  

• Locate and run the OMS Setup application 

• The Create a New Studio Setup dialog box appears. Click OK  
• Click the checkboxes to select the port (modem and / or printer) to which your MIDI 

interface is connected. USB MIDI interfaces will be detected regardless of these 
settings 

• Click Search. OMS will now search for MIDI interfaces connected to your computer 

• A list of the MIDI interfaces connected to your computer will be displayed. If this list is 
correct, click OK. If MIDI interfaces that you have connected to your computer are not 
detected, refer to the troubleshooting information 

• OMS will now attempt to detect devices (keyboards, modules, samplers, etc) that are 
connected to your MIDI interface. A list of devices or MIDI ports will appear. Click on 
the checkboxes next to each of the devices or ports that you wish to use. Click OK 

• You will now be presented with a standard Mac OS Save dialog. Name your 
configuration, choose a convenient place on your hard drive and click Save 
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• Your studio configuration will now be displayed. Check that the on-screen MIDI 
connections are the same as your studio’s physical connections. Device information 
(manufacturer, model, name, properties, receive channel(s) and icon) can be edited 
by double clicking on the device / MIDI Interfaces icon. To connect devices, drag them 
to a MIDI interface, disconnect devices, and click once on the in/out arrows 

• When you have completed the setup, choose Save from the File    menu 

• Quit OMS Setup  
• Locate and run the FreeMIDI Setup application 

• You will be asked whether you wish to use OMS or FreeMIDI. Choose FreeMIDI 
(this can be changed later from Preferences in the File menu within FreeMIDI 
Setup) 

• The Welcome to FreeMIDI dialog box appears. Click Continue  

• The FreeMIDI Preferences dialog box will appear. Ensure that only Allow 
other applications and Always load at startup are checked. Click OK to 
continue  

• The About Quick Setup dialog box appears. Click Continue  
• You will now see the Quick Setup window. In the New Device section of the 

Quick Setup dialog box specify the Manufacturer, Model, Studio Location 
(the name of the MIDI interface to which the device is connected) and Cable (the 
port to which the device is connected to if the specified MIDI interface has multiple 
ports). Click Add after specifying each device to add it to the Current 
Confgurations list 

• When you have specified the relevant information for each of your MIDI devices click 
Done. Make sure ‘Controller’ is selected in Properties if the device is to be used 
as an Input Device  

• Your studio configuration will now be displayed. Check that the on-screen MIDI 
connections are the same as your studio’s physical connections. Device / MIDI 
Interface information (name, ID, manufacturer, model, transmit channel(s), receive 
channel(s), properties and icons) can be edited by double clicking on the device/MIDI 
Interfaces icon  

• Choose Save from the File menu. Name your configuration and save it in a 
convenient place on your hard drive  

• Quit FreeMIDI Setup  
• Run Sibelius  
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• Setup the Equipment dialog in the same way as you would with OMS    – see MIDI 
Equipment in the Sibelius User Guide. 
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What’s new in PhotoScore Lite 
This update to PhotoScore Lite for Windows and Mac includes a number of new features 
and bug fixes, summarized as follows: 

• Playback added 

• MIDI file saving added 

• QuickTime Movie file saving on Mac 

• Reading options can now be chosen at beginning of read 

• Next/Previous buttons added for sorting through scanned images 

• Ability to turn off splash-screen at start-up 

• Various other minor improvements 

• Crash under Windows 95 fixed. 
 

Further details are included below for those changes which are not self-explanatory: 

Choosing options before reading 
If Display these preferences before reading is selected in the PhotoScore 
Preferences dialog box (on by default), you will get an opportunity to update certain 
preferences concerning accuracy and speed before reading begins. Click Read at the 
bottom right of the dialog box that appears to start reading. 

MIDI playback 
Another way to check for mistakes is to have the output played back to you. Your computer 
will need a MIDI device attached to make use of this feature (if you have more than one 
attached, the default one will be used). 

In order to have playback, the default MIDI device must not be in use by Sibelius; otherwise 
you will receive an error message. To make sure that the device is not in use, open the 
Equipment dialog box from Sibelius’s Play/Flexi-time menu, and make it so that for 
the default MIDI device, No is displayed under Use. If this is the device you use for 
playback within Sibelius, remember to reverse any changes once you have finished using 
PhotoScore. 

To play the whole page from the start, ensure that nothing is selected by clicking on an area 
of the page with no notation. Then choose Play/Stop from the Play menu. Alternatively 
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you can type P, or click Play on the toolbar. Do the same to stop the music. To play from a 
particular point on the page, select an object in each of the staves you want playback from. 
It will commence from the start of the bar with the earliest selection. 

While the music is playing, the currently played bars will be highlighted in grey.  

Saving MIDI files 
MIDI files were developed to store musical playback information, as opposed to printed 
notation, and as a result have a few limitations when it comes to storing scanned music. 
However, they are still very useful since virtually every music-editing product can read this 
type of file. 

Please observe the following when saving MIDI files: 

• Slurs, note stem and beam direction, end of stave & page positioning, staff size, and 
multiple-voice-per-staff separation cannot be stored. If a file is to end up in a separate 
notation package, then the final results are dependent on how that program interprets 
the music.  

• Musical features such as clef changes, rests, articulation marks, dotted notes, tuplets, 
dynamics, and ties also cannot be stored as objects in a MIDI file. However, if they are 
present PhotoScore Lite will emulate them for playback. To clarify: if the MIDI file is 
played back from a MIDI editing/playback program, the features should be heard, but 
the features will not necessarily be present if loaded and displayed in a scorewriting 
program.  

• Although features such as time signatures, key signatures, and text (like lyrics and title, 
but not dynamics as these are used to emulate changes in playback volume), are 
saved in the MIDI file, not all music software will necessarily use or display them. You 
may find there is an option in your music software to ignore or use such information.  

• Instruments allocated to each stave are stored according to the General MIDI 
standard. PhotoScore Lite intelligently works out what MIDI instruments should be 
used from the names entered to the left of each staff in the PhotoScore Lite output. 
These can of course be altered with a separate music program.  

• Due to MIDI file constraints, only the first 15 instruments in the score can be saved.  

• The tempo is always set to 100 Beats Per Minute (BPM). This can be altered with a 
separate music program. 


